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he User Interface chapter explains how to use Sunflower 
forms to manage assets as well as the toolbar, menus and 
the online help tools.

KE Y  CO N C E P T S

This chapter will include the following discussion points and concepts:

• Access Sunflower Enterprise

• Navigation

• System Concepts

• Search Techniques

• Wildcard Searches

• Define Complex Fields

• Get Help

• Error Management
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This section describes how to access the Sunflower application.The following steps guide users through the 
login process.

Step 1. Launch the Sunflower application. 

Step 2. Enter the unique Username.

Step 3. Enter the appropriate Password.

Step 4. Click the Login button. The Sunflower Enterprise Main Menu displays.

NAVIGATIOIN

• Launch Internet Explorer

• Enter the Sunflower 
application web address, 
or...

• Select the appropriate 
shortcut from the Favorites 
menu, or...

• If available, double-click the 
Sunflower icon on the 
desktop
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S U N F L O W E R  E N T E R P R I S E  M A I N  M E N U

Step 5. Select a hyperlink to access the appropriate area of Sunflower.

NOTE: The following example is based on clicking the Sunflower Enterprise Forms hyperlink. 

OPTION DEFINITION

Sunflower Enterprise Forms Accesses the Sunflower graphical user interface (GUI) forms.
Sunflower Enterprise Reports Accesses the Sunflower reporting main menu pages.
Sunflower Enterprise HTML Transaction Pages Accesses the Sunflower HTML Web transactions pages.

Search Attachments and Contracts Allows users to search for comments and attachments associated with 
contracts, assets and reports.

Sunflower Real Property Forms Accesses the Sunflower Real Property graphical user interface (GUI) 
forms.

Sunflower Real Property Reports Accesses the Sunflower Real Property reporting main menu page.
Logoff Used to Exit from Sunflower Enterprise.
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The following section explains how to navigate the menus and forms within Sunflower Enterprise.

S U N F L O W E R  M E N U S  

Each Sunflower module has a corresponding pull-down menu where users will navigate to perform most of 
their day-to-day tasks. Five of the menu selection items, Agree, Mgmt, Finance, Inactive, and Excess are 
known as Interest Asset modules.

NOTE: The Functions menu is only available when users have a form (screen, window, etc.) open.
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PULL-DOWN MENU FUNCTION

Exit Click Exit to close the Sunflower application.

Agree Manage assets associated with contracts, agreements, leases, warranties, property passes, and external 
contract related loans.

Contract Maintain Government related Contract Reports and manage the Unique Item Identifier (UII) feature.
Mgmt Record and maintain inventory management assets. (Typical day-to-day asset management).

Maintenance Manage preventative maintenance schedules, record emergency maintenance transactions and keep track 
of calibration status.

Sentry Check-Out, Check-In, Put Away, and Transfer selected sensitive assets, if installed.

Finance Manage the financial aspects of capitalized assets, such as the set up of journal entries for periodic cost 
and depreciation events.

Inactive Manage assets under storage, held for future use, repair, calibration, and/or acceptance.
Excess Manage assets during the retirement process. Implement screening periods and lotting processes.
Review Define and manage the physical inventory process.

IT Components Manage IT asset components that do not get tracked as individual assets but as subcomponents of an 
asset (i.e. software, hardware, license keys, etc.).

Configuration Create, manage and track asset configurations.

Admin Define and manage application, organization and end user properties. Perform system setup and 
maintenance.

Reports Generate reports related to each phase of the asset lifecycle.

Utility Provides another method of performing the various Sunflower Enterprise functions. Use the mouse, 
keyboard (hot keys) or the Functions menu. Note: Functions are only available when a form is open.

Window Cascade, tile window vertically or horizontally, or identify the form currently being worked in.
Help Access Sunflower’s on-line help.
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Sunflower is designed to operate in a Web-enabled environment. The window (screen, page, panel, etc.) is 
commonly referred to as a form. Other common terms are discussed below.

Step 1. Click Mgmt from the Menu Bar.

Step 2. Select Inventory Asset Summary and History from the pull-down menu (or submenu).

NOTE: The Mgmt submenu provides a list of menu items that pertain strictly to the Inventory 
Management module; however, while navigating from module to module, users will see that many of the 
submenus are the same. The Title Bar displays for each form and includes the form name and which 
page is being viewed. As a rule-of-thumb, use the Maintain menu items to actively edit forms and the 
Summary & History menu for viewing only.

NOTE: Notice that once a form is opened, the Tool Bar icons display below the Menu Bar and that the 
Functions pull-down menu is also available. Rest the mouse pointer over any icon to view a hint for the 
icon’s function. Hints display in the lower left-hand corner, on the Status Bar.

NAVIGATIOIN

• Click Mgmt

• Click Inventory Asset 
Summary and History
flower Systems © 2014 Sunflower Enterprise Assets 5.0 User Guide 15-6
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TERM DEFINITION

Button A graphic element that initiates a pre-defined action when clicked (i.e. Get Records, Timeline Report, etc.).
Check Box Allows for the selection (checking) of a single or multiple options.
Field An area within a window (form) that displays data or allows users to enter/update data.
Menu Bar A pull-down list of menus used to navigate to other forms or perform actions within a form.
Region A logical grouping of fields set apart from other fields by a box outline or a tabular area.
Region Tab A collection of regions that occupy the same space in a window where only one region can be displayed at a time.
Status Bar Displays status and other information related to form processing. Works in conjunction with the “Tool Tips” “Bubble.”
Title Bar Indicates the name of the form, pertinent context information and page information (i.e. Page 1 of 2, etc.).
Tool Bar Contains the icons, which are used to perform actions within a form or navigate to other associated forms.
Tool Tips “Bubble” help information created by resting the mouse over the top of an icon or button. Also used to determine the 

function of an icon or button on the toolbar or form.
Window A form. An area where the user interacts with the Sunflower application. Often multiple windows can be open at one 

time, allowing users to perform data entry and/or data search activities.
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Sunflower forms comprise of the following elements:

 NUMBER TERM DEFINITION

1 Menu Bar Categorical areas that have pull-down menus where users will navigate to perform most of their 
day-to-day tasks.

2 Tool Bar A collection of iconic buttons (icons) that perform specific actions when selected. 
3 Title Bar The name of the displayed form.

4 Required Field A yellow highlighted field indicates that the field is required. Required fields must be entered or 
the form will not Save.

5 Status Bar Displays status and other information related to form processing such as hints, number of 
records processed, and confirmation that records have been saved.
flower Systems © 2014 Sunflower Enterprise Assets 5.0 User Guide 15-8
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T O O L B A R  O V E R V I E W

The toolbar is a collection of iconic buttons (icons) that perform specific actions when selected. Each toolbar 
icon replicates a menu bar action. Depending on the context of the current field or form, a toolbar icon will be 
active or inactive. 

Display help (a Tool Tip) for an icon, by placing the mouse over the top of the icon.
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Save Clear Record Configuration and Kitting

Clear All Display List Catalog

Print Edit Document

Exit Help Comment/Picture/Attachment

Find Summary & History Location

Previous Block Initial Event Person

Next Block Ongoing Event Organization

Previous Record Final Event IT Component Summary and 
History

Next Record Resolution Lookup (Details icon)

Insert Record Journal Entry

Remove Record Agreement (if installed)
flower Systems © 2014 Sunflower Enterprise Assets 5.0 User Guide 15-10
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K E Y B O A R D  S H O R T C U T S  ( H O T  K E Y S)

Various keyboard shortcuts (hot keys) are available depending on the organization’s server settings. Use the 
Help menu to view the specific keys available for an organization.

NOTE: Copy (Ctrl+C) and Paste (Crtl+V) keyboard functions may also be available, based upon the 
operating system.

NAVIGATIOIN

• Click Help

• Click Keys
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The following concepts provide a sound basis for good asset management business practices.

• Location – The place where an asset resides.

• Catalog – Provides a consistent nomenclature.

• User Defined Fields (UDFs) – Captures information that is pertinent to a specific asset.

Knowing where assets are located is always a priority. As a result, Location is an important system field that 
is used to assign the physical location of every asset stored in Sunflower. To provide consistency in vendor 
and part naming, the Catalog is used to create a set of distinct manufacturer and model combinations for all 
assets stored in the database. Additionally, User Defined Fields (UDFs) can be enabled to capture unique 
information about assets which are defined by policy and/or procedures employed by an organization.
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L O C A T I O N

Location information is comprised of a group of fields that provide a granular view of an asset’s exact location. 
Location is referred to as a complex field because it is a combination of multiple fields. The specification of a 
location helps with record management and the tracking of assets.

NOTE: Users must have the Administrator role to view the Maintain Locations form.

Location information is comprised of the following primary fields:

NAVIGATIOIN

• Click Admin

• Click Location

• Click Maintain 
Locations

TERM DEFINITION

Site
A Required field. The most basic location data for the asset (i.e. on-site, off-site, region, city, building 
name, office name, airport, etc.).
Note: Site entry is associated with and controls Structure Level 1 data availability.

Structure Level 1
An Optional field that provides specific details about a Site’s location (i.e. Building, Lot, Baggage, 
Terminal, etc.) and, if applicable, the designation/number/name (i.e A, B, C, 1, 2, 3, 28, 100, 05C, 
TCT, Kennedy Center, United, etc.) assigned to a particular Site.

Structure Level 2
An Optional field that provides additional details about a Site’s location, (i.e. Floor, Room or Area) 
and the designation (i.e. 15, 123, Receiving, Storage, Carousel, etc.) or an Area’s type (i.e. Area A 
or Area B).

Mail Stop An Optional field used to specify the mail stop for a location.

Structure Level 3 Name
An Optional field that provides a free form text field used to specify additional details for Structure 
Level 2 such as a Bin, Palette, Cabinet, Vault, etc.
Note: If the Structure Level 2 field is blank, any Structure Level 3 data entered will not be saved.

GPS 1, 2, 3 Optional fields that provide specific Global Positioning System (GPS) location data.
Begin Date The Date in which the location is valid. If left blank, the location will remain valid.
End Date The Date in which the location becomes invalid. If left blank, the location will remain valid.
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The property catalog stores data common to an asset’s Manufacturer and Model number. The catalog is 
based on the manufacturers’ lists, and is updated as required to reflect new products. Having a well 
maintained catalog enables organizations to maintain a uniform way of entering manufacturer information 
quickly and precisely, especially when entering multiple assets. This standardization is important when 
running reports or queries to ensure search results are satisfactory.

NOTE: Organizations have the option to make the Official Name entry only selectable from a list of 
values (pick list), that is based upon the organization’s unique Property Management policy and 
procedures.

NOTE: The Asset Type field entry controls the default Service Life (yrs) field population.

NAVIGATIOIN

• Click <Interest Type> 
menu

• Click Maintain 
Catalog Entries
flower Systems © 2014 Sunflower Enterprise Assets 5.0 User Guide 15-14



S Y S T E M  C O N C E P T S . .
 . 

. .
U S E R  D E F I N E D  F I E L D S  ( U D F S )

User Defined Fields (UDFs) are “place holders,” used to define information that is unique to the organization. 
UDFs may include fields that contain a list of values, date entry or free text.

In the following illustrations notice how the User Fields* display different field entry requirements, based 
upon the Final Event Type selection criteria used.

NOTE: The Ellipsis (three dots) following the Organization field in the second illustration indicates that 
this field has a List of Values (LOV) available to assist with data entry.

NAVIGATIOIN

• Click Mgmt

• Click Create Inventory 
Asset Final Events

NAVIGATIOIN

• Click Mgmt

• Click Create Inventory 
Asset Final Events
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Retrieving data from the database is key in order to maximize effectiveness when working in Sunflower. This 
section will discuss and illustrate the most common methods in which users can search for and retrieve data, 
which include:

• Use the Asset Search form (perform a simple search)

• Use the Query Criteria form

• Use the Maintain Inventory Assets form

• Use the Summary and History form
flower Systems © 2014 Sunflower Enterprise Assets 5.0 User Guide 15-16
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P E R F O R M  A  S I M P L E  S E A R C H

Simple searches are derived by using the Asset Search form and provides a list of assets that meet the 
criteria selected. Perform a simple search and note that similar types of data are grouped together. Groups of 
data are sometimes separated by blocks. Users can “jump” between blocks by using the Next Block and 
Previous Block icons or the mouse. A scrollbar displays when there is additional information to view that 
does not fit within the current window. Users can search any interest (module) or multiple interests from this 
form.

Step 1. Navigate to the Asset Search form.

Step 2. Enter the known search criteria in the applicable fields.

Step 3. Click the Find icon to execute the search results.

Step 4. If applicable, use the Scrollbar or Next Record and Previous Record icons to view the list of 
items returned from the search.

Step 5. Optionally, click on the Report button for a shortcut to the Asset Search report.

NAVIGATIOIN

• Click Mgmt

• Click Asset Search
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Q U E R Y  F O R  A S S E T S

The Query Criteria form provides a way to enter additional data for a more detailed drill-down to view or work 
with specific assets. The Query Criteria form is unique in that it can be accessed from a variety of Sunflower 
main forms in which users want to search on assets and return the relative data.

Step 1. Navigate to the Maintain Inventory Assets form.

Step 2. With the cursor in the Identifier field, click the Find icon.

Step 3. Enter the known Search Criteria in the appropriate fields.

Step 4. Click the Execute button.

NOTE: Users are automatically returned to the Maintain Inventory Assets form, which will be populated 
with the results of their query.

NOTE: The Status Bar (located on the bottom left-hand corner), displays the number of returned records 
based on the search criteria.

NAVIGATIOIN

• Click Mgmt

• Click Maintain Inventory 
Assets

• Click Find
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NOTE: If the Record indication indicates 1/?, select Functions > Record > Last. This will provide the 
total count of records returned. Select Functions > Record > First to return to the top or first record.

NAVIGATIOIN

• Click the Next 
Record icon

FIELD NAME DESCRIPTION/EXPLANATION

Identifier Click the Next Record icon or use the Down Arrow on the keyboard to view the next record in the list of 
assets returned from the search.

Page 2 button Displays the Catalog information for the asset displayed.

Commodity button If activated, used to display commodity information (quantity, unit of measure, and description) for 
commodity assets.

Comment / Picture / 
Attachment button

Allows users to view attached comments, pictures, and/or other documents.

Re-Request button Used to re-release assets that were not accepted to a new steward.
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Clear the Form by clicking:

• The Clear All icon (second from the left, or located to the right of the Save icon) to clear all of the records 
and data from the form. This does not delete assets but simply erases the slate.

• The Clear Record icon to clear or close only one record at a time.

NAME ICON

Clear All

Clear Record
flower Systems © 2014 Sunflower Enterprise Assets 5.0 User Guide 15-20
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Q U I C K  S E A R C H

If the property record’s asset Identifier (Bar Code, Tag Number, Decal, etc.) is known, a quick search can be 
performed to find the data associated with that individual asset.

Step 1. Navigate to the Maintain Inventory Assets form.

Step 2. Enter the asset Identifier.

Step 3. Click the Tab key to display the search results.

NOTE: Notice the status bar on the bottom of the form displays the number of records retrieved by the 
search (1/1).

NOTE: Since only one record is open, click either the Clear All icon or the Clear Record icon to remove 
the data being displayed (this will not delete the data).

NOTE: If searching for an individual property record just to view the latest information, the Summary and 
History form is recommended.

NAVIGATIOIN

• Click Mgmt

• Click Maintain Inventory 
Assets
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The Summary and History form may become one of the most widely used forms that an organization will use 
to view asset information. It can be used to perform a quick search to find current as well as historical 
information associated with a specific asset Identifier or the Query mode can be used to display information 
about a group of assets.

Step 1. Navigate to the Inventory Asset Summary and History form.

Step 2. Enter the asset Identifier.

Step 3. Click the Tab key to display the asset timeline.

NOTE: The Timeline tab automatically displays, which provides a summary of events for the selected 
asset, with the most recent event listed at the top. If more than one event occurred at the same time, they 
are both listed, in Alphabetical order.

NOTE: Users control the amount of data displayed and how it is sorted by unchecking or checking the 
desired information to include and select the Sort By criteria. After making any changes, click the Get 
Records button to execute the revised search criteria.

Step 4. Select the Details tab to view detailed asset summary and/or historical information.

Step 5. Click the Clear All or Clear Record icon.

NAVIGATIOIN

• Click Mgmt

• Click Inventory Asset 
Summary and History

• Enter asset Identifier

• Click the Tab key
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NOTE: Select the Include history checkbox prior to entering the asset Identifier, to include historical 
information for the asset record(s).

Step 6. If the Include history checkbox is selected, view the data, as shown below. Use the Vertical scroll 
bar and Lookup icons as required.

The (circled) field adjacent to the Include history checkbox provides one of the following 4 displays:

NOTE: Users can view an asset’s Summary and History from any Sunflower form that displays the asset 
Identifier. Simply select the asset Identifier field and then click the Summary and History icon. When 
clicking the Summary and History icon, the Include history checkbox is automatically checked.

DISPLAY GRAPHIC DESCRIPTION/EXPLANATION

Blank Either there are no historical data entries for this asset, or the Include 
history checkbox was not enabled.

Down “Carrot”
The user is viewing the “first” or latest record. Click the Next Record 
icon, the Down Arrow on the keyboard, or use the Vertical scroll bar to 
view the next record(s).

Up & Down “Carrots” The user is between the “first” (latest) record and the “last” (initial entry) 
record.

Up “Carrot”
The user is viewing the “last” or initial entry record. Click the Previous 
Record icon, the Up Arrow on the keyboard, or use the Vertical scroll 
bar to view the previous record(s).
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Use wildcards to search a List of Values (LOV) field. When a field contains a LOV (pick list) that users can 
choose from, enter a wildcard character (%) in the search phrase to narrow the list of options as desired. 
However, when using wildcards, users cannot use query operators (such as >, <, =, and so on) in a Query 
Criteria window.

Auto Selection

Using the List of Values feature called Auto Selection, users can select a valid name from the list with a single 
keystroke. When displaying the list window, users can type the first character of the name wanted in the Find 
field. If only one choice begins with the character entered, Auto Selection selects the choice, closes the list 
window, and enters the value in the appropriate field. If the first character has more than one choice, users 
can either select from the List of Values or enter additional characters before Tabbing out of the field.

List Search

Use the AutoReduction feature to reduce a list when the first few characters of the name selection is known. 
If the initial characters of the choice are not known, but it is known that the choice contains a certain word or 
set of characters, users can perform a list search to reduce a list. In the list window, enter any group of 
characters as search criteria in the Find field and click the Find button. Use wildcard characters such as the 
percent sign (%) which represents any number of characters, or an underline (_), which represents only a 
single character in the search criterion. For example, to reduce a list to only those choices that contain the 
phrase “schedule,” users could type %sched% in the Find field and then click Find. In any of these list search 
queries, it does not matter whether using uppercase or lowercase letters as the search is not case sensitive.

Wildcards

Wildcards can be used to search any field for which there is a List of Values (LOV). The LOV feature is useful 
while entering data in Sunflower applications. It provides users with a powerful, easy-to-use data entry 
method that increases accuracy and productivity. Using the LOV makes data entry a simple task for novice 
users, and experienced users can enter correct data with a minimum number of keystrokes.

Sunflower notifies users when a list acceptable input value is available for a field by displaying the LOV icon 
(Ellipsis) in the field and displaying List of Values in the Status Bar. When displaying a list, the values appear 
in a pop-up window with a title that describes the contents.
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U S I N G  T H E  L I S T  O F  V A L U E S  ( L O V )

Using the LOV feature in combination with wildcards can save time and maximize correct data entry without 
having to memorize or look up valid data for each field. Simply choose data from an online list of valid input 
choices whenever needed. Additionally, users are relying on Sunflower applications to validate input since 
they will know right away if the entry does not match an option from the LOV. The combination of the (%) with 
a character will display sets of results. 

• Use % to return the complete List of Values. (A blank field works the same as using %.)

• Use a character + % to return all values that begin with the entered character(s).

• Use % + a character to return all values that contain the entered characters anywhere within the value.
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%  W I L D C A R D  S E A R C H

Use a wildcard “%” to Return a Complete List of Values.

Step 1. Navigate to the Asset Search form.

Step 2. Double-click in the Manufacturer field (% will default) to view the returned list of values. 

NOTE: A blank field or a field with % entered will return all listed (or table) items.

NOTE: Clicking the Cancel button will discard retrieved results and close the LOV.

NOTE: In this example, the Status Bar indicates that there are 13 choices in the list. Entering a % is the 
same as entering nothing in the field and double-clicking to display the entire list of values. 

NAVIGATIOIN

• Click Mgmt

• Click Asset Search
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U S E  C H A R A C T E R  +  %  W I L D C A R D  T O  S E A R C H

Step 1. Navigate to the Asset Search field.

Step 2. Enter A% in the Manufacturer field.

Step 3. Double-click in the Find field or select the Find button to view the returned List of Values.

NOTE: Notice that only those words that start with the character “A” are displayed.

Step 4. Click the Cancel button to discard retrieved results and close the LOV.

Step 5. Click the Clear All icon to clear the form.

NAVIGATIOIN

• Click Mgmt

• Click Asset Search
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The Report button is a shortcut to Reports within Sunflower Enterprise. It automatically opens the Asset 
Search Report and populates the appropriate fields as they were entered on the form. In order to use this 
feature users may need to disable their browser’s “Pop-up Blocker” feature; an example of how to disable 
pop-ups is shown below (for Microsoft Internet Explorer). Users may also have a separate tool bar with pop-
up blocker features displayed. 

Step 1. On the Internet Explorer Menu Bar select Tools > Internet Options...

Step 2. Click the Privacy tab.

Step 3. Uncheck Block pop-ups.

Step 4. Click the Apply button.

Step 5. Click the OK button.
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U S E  %  W I L D C A R D  +  C H A R A C T E R  T O  S E A R C H

Step 1. Navigate to the Asset Search field.

Step 2. Enter %A in the Manufacturer field.

Step 3. Double-click in the Find field or select the Find button to view the returned List of Values.

NOTE: Notice that only those words that contain the character “A” anywhere in the name are displayed.

NAVIGATIOIN

• Click Mgmt

• Click Asset Search
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A Complex Field is a grouping of related fields that are displayed in the form of a pop-up window. Common 
complex fields are Location*, Document*, Names*, Catalog*, and User Fields*. For example, Location* is a 
combination of several fields that include Site, Building, Room, etc. All complex fields are represented by their 
name followed by an asterisk (*), such as Location*.

In this example, view the Location* (complex field) data for an existing asset.

Step 1. Navigate to the Maintain Inventory Assets form.

Step 2. Enter the asset Identifier.

Step 3. Click the Tab key.

Step 4. Double-click in the Location* field. The Maintain Location pop-up window displays.

Step 5. Verify or edit the existing Location data.

Step 6. Click the Save icon to close the complex field window.

Step 7. Click the Exit icon or X located in the upper right corner of the window to Exit without saving.

NAVIGATIOIN

• Click Mgmt

• Click Maintain Inventory 
Assets
flower Systems © 2014 Sunflower Enterprise Assets 5.0 User Guide 15-30



G E T  H E L P . .
 . 

. .
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .G E T  H E L P

Use the online Help system to learn more about a form’s function and/or purpose. Since the Help System is 
context-sensitive it will open to the help page that corresponds to the current form. A brief description of the 
form is provided along with a list of common tasks that can be accomplished. Select a Help option (hyperlink) 
to receive step-by-step instructions about how to perform a task.

To access online Help, click the Help icon (?) or select Help > Help from the menu bar to view helpful topics 
for the specified form. Following is an example of how to use the Help feature. A form must be open in order 
to use the Help (?) icon.

Step 1. Navigate to the Maintain Inventory Assets form.

Step 2. Click ? (Help icon) or click Help>Help. The Help results open in a separate window.

Step 3. Select the appropriate hyperlink to learn more about a specific topic.

NOTE: The Toolbar Help button can be used to review the Tool Bar icons and their uses.

NOTE: The Help Index button can be used if the activity to perform is known, but it is not known where 
to locate it within the Help System. It can be searched.

NOTE: The Search button enables users to enter a word or phrase in the Search For field and click 
Search.

NAVIGATIOIN

• Click Mgmt

• Click Maintain 
Inventory Assets

• Click ? icon
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NOTE: The Return To Main Help button can be used to review help for another module.

Step 4. Click X or File>Close to exit Help.

NOTE: If an organization is using the Sunflower Term Set feature to alter selected field names, users 
need to be aware that Term Set changes do not effect the Help index “static” HTML pages.
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If a user attempts to move past a required field without entering data, Sunflower Enterprise will notify the user 
by displaying an error message indicating the a required field has been missed. In order to return to the 
missed field, use any of the following short-cut key strokes to back out of a required field.

• Hold down the Shift key and click the Tab key (Shift + Tab) on the keyboard.

• Enter data in the required field and then use the mouse to return to the previous field.

• Click the Clear Record icon to clear all of the data and begin data entry again.
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